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Module 1: Course Navigation 
Lesson 1: ACE Web-based Training Navigation 
 
Screen 1: 
 
Lesson 1: Automated Commercial Environment (ACE) Web-based 
Training Navigation 
 
 
After completing this lesson, you will be able to: 
 

• Explain the ACE Web-based training course structure.  
• Use the Navigation Bar buttons to move through course screens. 
• Use interactive course features such as rollovers and 

simulations. 
 
Select Next to continue. 
  
Image:  Computer monitor displaying the ACE logo. 
 
Buttons:  Select Pause to temporarily stop the course. 
              Select Back to return to the previous screen. 
              Select Next to continue. 
              Select Exit to return to the course menu screen. 
 
 
Screen 2: 
 
Course Disclaimer 
 
The names of companies and persons mentioned in all ACE Web-based 
training courses are fictional. Information related to addresses, e-
mails, phone numbers, license numbers, etc, is used solely for 
instructional purposes and should not be considered valid data. 
 
Course screenshots and simulations of the ACE Secure Data portal 
were captured from a test environment; as a result, slight differences 
may occur in the look and functionality of ACE due to date of 
publishing. 
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Select Next to continue. 
 
Image: A gavel lying on top of a document. 
 
Buttons: Select Pause to temporarily stop the course. 
             Select Back to return to the previous screen. 
             Select Next to continue. 
             Select Exit to return to the course menu screen. 
 
 
Screen 3: 
 
Course Structure 
 
Each ACE Web-based training course follows a module and lesson 
structure.  Each module is divided into a number of lessons. 
 
The course menu reflects a list of modules on the left and the 
associated list of lessons on the right. To begin the course, select a 
module name and then the lesson name. 
 
Each ACE Web-based training course is designed to allow you to 
proceed at your own pace. You can complete the course modules and 
lessons in one sitting or in stages. 
 
Select Next to continue. 
 
Image: Sample ACE Web-based Training menu displaying Module links 
on the left and Lesson links on the right. 
 
Buttons: Select Pause to temporarily stop the course. 
             Select Back to return to the previous screen. 
             Select Next to continue. 
             Select Exit to return to the course menu screen. 
 
 
Screen 4: 
 
Using the Navigation Bar 
 
At the bottom of each lesson screen, there is a Navigation Bar. The 
Navigation Bar allows for movement through the screens of an ACE 
Web-based training course. 

4 



Web-based Training Guide for  Module 1, Lesson 1 
ACE Initial Login for Trade Account Owners 

 
Select Next to continue. 
 
Image: Chart that shows Navigation Bar Options (see below) and 
definitions. 
 
Navigation bar Options 
 
Pause button, temporarily stops the slide. 
Next button, moves to the next slide. 
Back button moves to the previous slide. 
Exit button, closes the lesson and returns to the Course Menu. 
Progress Bar shows overall progress and allows movement through the 
slides in either direction. 
 
Buttons: Select Pause to temporarily stop the course. 
             Select Back to return to the previous screen. 
             Select Next to continue. 
             Select Exit to return to the course menu screen. 
 
 
Screen 5: 
 
Navigating Interactive Simulations 
 
A simulation is an interactive feature that imitates real world use. The 
example below describes how highlighting and captions are used as 
guidance in simulations. 
 
Callout: When using the simulations, select areas highlighted in red to 
complete steps. 
 
Callout: Blue directional captions provide instructional steps to follow. 
 
Image: Partial ACE secure data portal screenshot with arrows pointing 
to callouts. 
 
Select Next to continue. 
 
Buttons: Select Pause to temporarily stop the course. 
             Select Back to return to the previous screen. 
             Select Next to continue. 
             Select Exit to return to the course menu screen. 
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Screen 6: 
 
Rollovers 
 
Rollovers are images that change to display additional details or 
information when a mouse cursor is positioned over a specified 
location. The text that appears is called rollover text. 
 
The example to the left contains rollovers. Position your mouse cursor 
over the image to reveal related rollover text. 
 
R1 rollover displays Basic Foundational Design - released 2001. 
R2 rollover displays Functionality to the Trade - released 2003. 
R3 rollover displays Periodic Monthly Statement - released 2004. 
R4 rollover displays E-manifest Trucks - released 2005. 
 
Select Next to continue. 
 
Image: Diagram of ACE Releases, R1, R2, R3 and R4. 
 
Buttons: Select Pause to temporarily stop the course. 
             Select Back to return to the previous screen. 
             Select Next to continue. 
             Select Exit to return to the course menu screen. 
 
 
Screen 7: 
 
You have completed Lesson 1: ACE Web-Based Training Navigation. 
 
In this lesson you learned how to navigate an ACE Web-based training 
course. 
 
Select Exit to return to the Menu. 
 

Image: Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
 
Buttons: Select Pause to temporarily stop the course. 
             Select Back to return to the previous screen. 
             Select Next to continue. 
             Select Exit to return to the course menu screen. 
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Module 2: ACE Initial Login for Trade 
Account Owners 
Lesson 1: Retrieving the Temporary Password 

 
Screen 1: 
 
Lesson 1 Temporary Password 
 
Lesson 1 demonstrates how to retrieve the temporary password 
needed for the initial login to the Automated Commercial Environment 
(ACE) secure data portal. 
 
After completing this lesson, you will be able to: 
 

• Retrieve your temporary password  
 
Select Next to continue. 
  
Image:  Computer monitor displaying the ACE logo. 
  
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 2: 
 
As the Trade Account Owner (TAO), you will receive two e-mails that 
contain information about your new ACE portal account. 
 
You will need information from both of these e-mails in order to 
perform the initial login to the ACE portal. 
 
One of the e-mails is from aceuserservice@cbp.dhs.gov and contains: 
 

• Your Account ID or UserID; 
• Link to your temporary password. 
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Tip: If you do not receive this first e-mail, look in your junk or spam 
folders. E-mail firewalls may forward incoming mail to these folders. 
 
The other e-mail is from the account administrator who created your 
account. This e-mail: 
 

• Notifies you of your account creation; 
• May contain your shared secret; and 
• Provides instructions for logging in to the ACE portal. 

 
Select Next to continue. 
 
Image: Green rectangles surrounding the text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 3: 
 
When you get access to the ACE portal, you will get an e-mail from 
aceuserservice@cbp.dhs.gov.  Open the e-mail and select the enclosed 
link to retrieve your temporary password.  
 
Text caption displays: Open the New Account Information e-mail 
 
Image: Screenshot of a Microsoft Outlook Inbox with a message from 
aceuservice@cpb.dhs.gov. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
 
 
 
Screen 4: 
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Prior to selecting the Retrieve Password link, be sure to write down the 
Account ID that is provided in this e-mail.  The ID will be used as your 
"Shared Secret" to access your temporary password.  It will also be 
the ID you use to log into the ACE system.  
 
The temporary password must be retrieved within 21 days from the 
time the e-mail was created or it will expire.  If the password expires, 
you must contact the ACE Technology Support Center to have it reset. 
 
Select the link on this e-mail to access the temporary password. 
 
Text caption displays: Select the link. 
 
Image: Screenshot of an opened message from 
aceuserservice@cbp.dhs.gov displaying and ACE Email Notification 
message. The message contains a Retrieve Password Page link. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 5: 
 
Once you select the Retrieve Password link from your e-mail, ACE 
displays the Retrieve Password page and automatically enters an 
access number in the Transaction ID text box. 
 
Your next step is to enter the shared secret you received in the e-mail 
from the account administrator. The shared secret is only needed to 
retrieve your temporary password. 
 
If you did not receive this e-mail, contact the Technology Support 
Center available 24-hours a day, seven days a week at 1-866-530-
4172. 
 
Text caption displays: Select the Shared Secret field 
 
Image: Retrieve Password Page containing Transaction ID and Shared 
Secret text fields as well as submit and cancel buttons. 
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Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 6: 
 
Text Caption displays: Select the Submit button 
 
Image: Retrieve Password Page containing Transaction ID and Shared 
Secret text fields as well as submit and cancel buttons. Transaction ID 
and Shared Secret text fields are filled with data. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 7: 
 
The temporary password allows you to log in to the ACE secure data 
portal for the first time.  Note that the temporary password is a 
completely random collection of Capital letters, lower-case letters, 
numbers, and special characters. 
 
When you get the temporary password, make sure you record it.  
Once you select the Finished Viewing Password link, you will not be 
able to retrieve the password again. 
 
Text caption displays: Select the Finished Viewing Password button 
 
Image: Password Retrieval Page containing the following fields and 
associated data: Resource Name, Your Account ID, and Your password 
is. The page also contains a Finish viewing password button. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 8: 
 
The Technology Support Center 
 
For additional assistance, call the Technology Support Center 1-866-
530-4172 and follow the prompts. 
 
The Technology Support Center is available 24 hours a day and 7 days 
a week. 
 
Select Next to continue. 
 
Image: A woman working at a computer. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 9: 
 
You have completed Lesson 1: Retrieving the Temporary Password 
   
In this lesson, you learned how to retrieve your temporary password. 
 
Select Exit to return to the Menu. 
 
Image: Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Lesson 2: Creating Your ACE Password 
 
Screen 1: 
 
Lesson 2: Creating Your ACE Password 
 
Lesson 2 demonstrates how to create a new password when logging 
into the Automated Commercial Environment (ACE) secure data portal 
for the first time. 
 
After completing this lesson, you will be able to: 
 

• Create your ACE password. 
• Select security questions to aid in the event that you need to 

reset your password. 
 
Select Next to continue. 
 
Image: Computer monitor displaying the ACE logo. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 2: 
 
To access the ACE secure data portal login page, you must open a Web 
Browser.  
 
Text caption displays: Open the Internet Explorer Web Browser icon 
 
Image: Computer Desktop with icons including Internet Explorer. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 3: 
 
Once you open a Web Browser, type https://ace.cbp.dhs.gov in the 
Address line. Select the Go button in order to open the ACE login 
screen. 
 
Text caption displays: Select the Go button 
 
Image: The CBP.gov website as displayed in Internet Explorer. The top 
of the screen features an Address line with a Go button to its right. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 4: 
 
Log into the ACE portal as a new account user to choose your 
challenge response questions and reset your password. 
 

Text caption displays: Scroll down 
 
Image: The top portion of the ACE secure data portal login page. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 5: 
 
This is the ACE secure data portal login page. You are now ready to 
type your UserID. Select the UserID field to continue. 
 
Text caption displays: Select the UserID field 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. Neither field currently contains text. 
 
Buttons:  
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Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 6: 
 
The next step is to type the temporary password you just retrieved. 
Select the Password field to continue. 
 
Text caption displays: Select the Password field 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. The User ID field contains text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 7: 
 
Text caption displays: Select the Login button. 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. The User ID and Password fields contain text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 8: 
 
The screen displayed here confirms you entered your UserID and 
temporary password correctly.  The next step in the initial login 
process is to set five challenge response questions. 
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Select Next to continue. 
 
Image: The ACE secure data portal – New User-Set Challenge 
Response Questions page 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 9: 
 
At the Reset Password Challenge Questions page, you will need to 
select and answer five different challenge questions from the list of 14 
questions.  
 
To begin, select the first challenge question drop-down menu arrow in 
order to display a listing of options. 
 
Note: As with passwords, answers to response questions are case 
sensitive. It is recommended that you use either all upper or lower 
case when typing in responses.  
 
Text caption displays: Select the Question 1 drop-down menu 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 10: 
 
These challenge questions are used to validate your identity should 
you need to reset your password. 
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For this demonstration, we are going to select "What is your 
birthplace?" 
 
Text caption displays: Select what is your birth place? Item 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. The drop-down menu associated with question 1 is 
expanded with a list of several question options from which the user 
can make a selection. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 11: 
 
Select the first Question 1 field and we will type a response to the first 
challenge question for you. 
 
Text caption displays: Select the first Question 1 field 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 12: 
 
Select the second Question 1 field for the first challenge question.  
 
ACE requires each challenge question to be answered twice. 
 
Text caption displays: Select the second Question 1 field 
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Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. The first text field associated with question 1 is filled. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 13: 
 
Text caption displays: Select the Question 2 drop-down menu 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. The text fields associated with question 1 are filled. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 14: 
 
Text caption displays: Select what is your mother’s maiden name? 
Item 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. The drop-down menu associated with question 2 is 
expanded with a list of several question options from which the user 
can make a selection. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 15: 
 
Text caption displays: Select the first Question 2 field 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. The text fields associated with question 1 are filled. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen16: 
 
We will answer the rest of the challenge questions for you. 
 
Text caption displays: Select the second Question 2 field 
 
Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. The text fields associated with question 1, and the first 
text field associated with question 2 are filled. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 17: 
 
Once all of your questions have been answered, you may submit your 
answers. In case you forget your password in the future, ACE will 
prompt you to answer three of these questions, selected randomly, 
before resetting your password. 
 
Text caption displays: Select the Submit Questions button 
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Image: The ACE secure data portal – Reset Password-Challenge 
Questions page. This page contains drop-down menus for five 
challenge questions and two corresponding text fields for answering 
each question. The text fields associated with all of the challenge 
questions are filled. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 18: 
 
You are now prompted to choose a new password. First let's look at 
the Password Policy. 
 
Text caption displays: Select the Password Policy link 
 
Image: The ACE secure data portal – Reset Password page. This page 
includes instructions for resetting one’s password, a link to the 
Password Policy, and text fields to allow users to change their 
passwords. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 19: 
Take a few moments to read the password policy parameters before 
you select the Close button. 
 
Note: When you change your password at some future date, you will 
not be able to reuse the last six passwords. 
 
Text caption displays: Select the Close button 
 
Image: The ACE secure data portal – ACE Password Policy page. 
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Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 20 
 
Now that you have reviewed the password policy, you are ready to 
select the New Password field and type your new password. 
 
Text caption: Select the New Password field 
 
Image: The ACE secure data portal – Password reset page. This page 
includes two text fields: New Password and Retype New Password. 
Both fields are required. This page also includes Continue and Cancel 
buttons. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 21 
 
Confirm your new password by typing it again. 
 
Text caption displays: Select the Retype New Password field 
 
Image: The ACE secure data portal – Password reset page. The New 
Password is filled. 
  
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 

20 



Web-based Training Guide for  Module 2, Lesson 2 
ACE Initial Login for Trade Account Owners 

Screen 22 
 
Text caption displays: Select the Continue button 
 
Image: The ACE secure data portal – Password reset page. The New 
Password and Retype New Password fields are filled. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 23 
 
To completely close the Web browser, answer yes to the prompt 
confirming you want to close. 
 
Text caption displays: Select the Yes button 
 
Image: Pop-up box asking if the user wants to close this window. 
Options include a Yes and No button. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 24 
 
Closing the web browser may include other Internet windows you are 
separately working on and even your e-mail if it is intranet based like 
Microsoft Outlook web mail or Hotmail. 
 
Now that you have selected the Yes button to close the Web Browser, 
make sure you close all other Web Browsers. 
 
Select Next to continue. 
 
Image: A computer desktop. 
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Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 25 
 
The Technology Support Center 
 
For additional assistance, call the Technology Support Center 1-866-
530-4172 and follow the prompts. 
 
The Technology Support Center is available 24 hours a day and 7 days 
a week. 
 
Select Next to continue. 
 
Image: A man working on a computer. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 26 
 
You have completed Lesson 2: Creating Your ACE Password 
   
In this lesson, you learned how to: 
 
Create your ACE password. 
Establish your challenge questions which will aid you in the event you 
need to reset your password. 
 
Select Exit to return to the Menu. 
 
Image:  Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
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Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Lesson 3: Initial Login to the ACE Portal 

 
Screen 1: 
 
Lesson 3: Initial Login to the ACE Portal 
 
Lesson 3 demonstrates how to log into and log out of the ACE secure 
data portal. 
 
After completing this lesson, you will be able to: 
 

• Log into the ACE secure data portal. 
• Log out of the ACE secure data portal. 

 
Select Next to continue. 
 
Image:  Computer monitor displaying the ACE logo. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 2 
 
To log into the ACE portal, open a new Web browser. 
 
Text caption displays: Open the Internet Explorer Browser icon to open 
a new Web browser 
 
Image: A computer desktop. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 3 
 
Type https://ace.cbp.dhs.gov in the Address line. 
 
Text caption displays: Select the Go button 
 
Image: The CBP.gov website as displayed in Internet Explorer. The top 
of the screen features an Address line with a Go button to its right. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 4 
 
Text caption displays: Scroll down 
 
Image: The top portion of the ACE secure data portal login page. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 5 
 
This is the ACE secure data portal login page. You are now ready to 
select the UserID field and enter your UserID. 
 
Select the UserID field and we will enter the UserID for you. 
 
Text caption displays: Select the UserID field 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. Neither field currently contains text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
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Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 6 
 
The next login step to the ACE secure data portal is to select the 
Password field and enter your password.  
 
Select the Password field and we will enter the password for you. 
 
Text caption displays: Select the Password field 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. The User ID field contains text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 7 
 
Text caption displays: Select the Login button. 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. The User ID and Password fields contain text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 8 
 
This is the ACE secure data portal with the Home tab displayed.  
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Note: Navigating through the ACE secure data portal can only be done 
using the buttons, tabs, drop-downs, and icons located within the ACE 
secure data portal.  You should not use the icons on your web browser 
toolbar, particularly the Back button.  These can cause problems with 
your ACE session and may cause pages not to display or data to be 
lost. 
 
Select Next to continue. 
 
Image: ACE secure data portal with the Home tab displayed. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 9 
 
To log off the ACE portal, select the Logoff icon located in the upper 
right-hand corner of the navigation bar.  Scroll to the right in this 
demonstration. 
 
Text caption displays: Scroll to the right 
 
Image: ACE secure data portal with the Home tab displayed. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 10 
 
Text caption displays: Select the Logoff icon to close the ACE portal 
 
Image: ACE secure data portal with the Home tab displayed. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
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Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 11 
 
When you log off of the ACE Portal, you are returned to the login page. 
 
Select next to continue. 
 
Image: ACE secure data portal login page. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 12 
 
The Technology Support Center 
 
For additional assistance, call the Technology Support Center 1-866-
530-4172 and follow the prompts. 
 
The Technology Support Center is available 24 hours a day and 7 days 
a week. 
 
Select Next to continue. 
 
Image: A woman working at computer. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 13 
 
You have completed Lesson 3: Initial Login to the ACE Portal 
   
In this lesson, you learned how to log into and log out of the ACE 
secure data portal. 
 
Select Exit to return to the Menu. 
 

Image:  Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Lesson 4 Setting Up Your Carrier Record 
 
Screen 1: 
 
Lesson 4: Setting Up Your Carrier Record 
 
Lesson 4 demonstrates how to set up carrier records in the Automated 
Commercial Environment (ACE) secure data portal. Trade Account 
Owners are the highest level Trade role in the ACE secure data portal. 
 
After completing this lesson, you will be able to: 
 

• Set up a Carrier record. 
 
Select Next to continue. 
 
Image:  Computer monitor displaying the ACE logo. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 2 
 
In the first three lessons we learned how to retrieve your temporary 
password, set your challenge questions and your permanent password, 
and log into ACE for the first time.  In this lesson, we will see how to 
set up your ACE account information. 
 
If you log off of the ACE secure data portal before setting up your 
carrier's record, you can access ACE through your favorites or by 
typing https://ace.cbp.dhs.gov in your Web browser window.  
 
Once you reach the ACE login page, select the UserID field and enter 
your UserID. 
 
To continue, select the UserID field and we will type the UserID for 
you. 
 
Text caption displays: Select the UserID field 
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Image: The ACE secure data portal login page with text fields for 
UserID and Password. Neither field currently contains text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 3 
 
Next, select the Password field and we will type the password for you. 
 
Text capture appears: Select the Password field 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. The User ID field contains text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 4 
 
And now select the Login button. 
 
Text caption displays: Select the Login button 
 
Image: The ACE secure data portal login page with text fields for 
UserID and Password. The User ID and Password fields contain text. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 5 
 
This is the home page for the ACE secure data portal.  
ACE displays this screen whenever you login. 
 
To view account information, go to the Accounts tab. 
 
Text caption displays: Select the Accounts tab 
 
Image: ACE secure data portal with the Home tab displayed. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 6 
 
At the ACE portal Accounts page, Broker is the account type that is 
selected by default. 
 
To change the account type to carrier, you must first select the View 
drop-down menu in the Select Account Type section of the Task 
Selector panel. 
 
Text caption displays: Select the Account Type drop-down menu 
 
Image: ACE secure data portal with the Accounts tab displayed. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 7 
 
From the drop-down menu, select Carrier. 
 
Text caption displays: Select Carrier 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the View drop-down menu expanded. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 8 
 
Text caption displays: Select the GO button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 9 
 
Review the listings of top accounts located in the Account Selector List 
portlet. 
 
To expand a top account list to display both parent and subsidiaries, 
select the plus sign [+] adjacent to the top account on the lower left 
side of the screen. 
 
Text caption appears: Select the [+] next to CBP Incorporated 
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Image: ACE secure data portal with the Accounts tab displayed. CBP 
Incorporated is the only account listed in the Account Selector List 
portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 

Screen 10 
 
Select the subsidiary company name to display a list of options. 
 
Text caption displays: Select the carrier account name 
 
Image: ACE secure data portal with the Accounts tab displayed. Data 
relating to the CBP Incorporated Top Account page is displayed in the 
View Top Account portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 11 
 
You can now view the Carrier portlet for the selected carrier. The 
message at the top of the portlet, "No Contact Persons Found," 
prompts you to add the missing carrier information. 
 
The next step is to enter the taxpayer ID information for the selected 
Carrier.  
 
Select Next to continue. 
 
Image: ACE secure data portal with the Accounts tab displayed 
containing the Carrier portlet. 
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Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 12 
 
Enter the taxpayer ID by using one of the following two Taxpayer ID 
Type options: 
 
1) USA: Social Security Number 
2) USA: Employer ID Number 
 
Note: If your carrier is a Canadian or Mexican company and does not 
have a US Taxpayer ID, select USA: Employer ID Number as the 
Taxpayer ID Type and type 99-9999999 as the Taxpayer ID #.  
 
Then select the Organization Structure. 
 
In this simulation we will skip adding this information.  Select the 
Continue button to continue. 
 
Text caption displays: Select the Continue button. 
 
Image: ACE secure data portal with the Accounts tab displayed 
containing the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 13 
 
Next, enter the address information for the selected carrier. All 
address text boxes with an asterisk are required. In this simulation we 
will add the address information for you.  Select the Save button to 
continue. 
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Note: Although the State/Province text box and the Zip/Postal Codes 
text box do not have an asterisk next to them, you are still required to 
enter the information. 
 
Text caption displays: Select the Save button 
 
Image: ACE secure data portal with the Accounts tab displayed 
containing the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 14 
 
When the required address information has been entered, ACE displays 
the "Address has been standardized" message in red at the top of the 
screen.  
 
Note: If there is a problem with an address, ACE asks you if you want 
to use the address anyway. Check for errors before accepting the 
address. 
 
Select Next to continue. 
 
Image: ACE secure data portal with the Accounts tab displayed 
containing the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 15 
 
The Technology Support Center 
 
For additional assistance, call the Technology Support Center 1-866-
530-4172 and follow the prompts. 
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The Technology Support Center is available 24 hours a day and 7 days 
a week. 
 
Select Next to continue. 
 
Image: A man working at computer. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 16 
 
You have completed Lesson 4: Setting Up Your carrier Record 
   
In this lesson, you learned how to set up a carrier record. 
 
Select Exit to return to the Menu. 
 

Image:  Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Lesson 5 Adding a Company Contact 
 
Screen 1: 
 
Lesson 5: Adding a Company Contact 
 
Lesson 5 demonstrates how to add a company contact in the 
Automated Commercial Environment (ACE) secure data portal. 
 
After completing this lesson, you will be able to: 
 

• Add a point of contact for a carrier. 
 
Select Next to continue. 
 
Image:  Computer monitor displaying the ACE logo. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 2: 
 
After entering the tax ID and organization structure, ACE prompts you 
to enter a point of contact for the newly created company. As the 
Trade Account Owner (TAO), you may be the point of contact for the 
company. 
 
To begin, enter the point of contact name in the Last Name field and 
select the Search button. 
 
Text caption displays: Select the Last Name field 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. The search criteria discussed are contained 
in the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
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Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 3 
 
Text caption displays: Select the Search button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. The button mentioned is contained in the 
Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 4 
 
If you are the TAO, your account information is already stored within 
the ACE program. 
 
We will now go through the procedure for adding this existing contact 
information to your carrier's record as the point of contact. 
 
Text caption displays: Select the Select and Continue button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Search results and two buttons (Select and 
continue, and Cancel) are contained in the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
 
 
Screen 5 
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ACE now displays the information on file for the point of contact. You 
can review the information and answer the question, Is the Contact 
Address the same as the Person Address?  You would select Yes if the 
address stored with the person is the address used as their contact 
information for this account. 
 
For this demonstration, we will use the default selection, No, because 
there is no address stored with Diane Sanchez. 
 
Text caption displays: Select the Continue button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Detailed information about the carrier’s point 
of contact is displayed in the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 6 
 
You can use this screen to update addresses. 
 
Text boxes with an asterisk (*) indicate the information is required. 
 
We have filled in this information for you for this simulation.  Once the 
information is complete, you can select Save. 
 
Text caption displays: Select the Save button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Form fields associated with the carrier’s 
point of contact are displayed in the Carrier portlet.  
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 7 
 
Once you select Save, ACE returns you to the Accounts task. If you are 
unable to view the bottom of the Carrier portlet, scroll down to confirm 
the ACE program has added your point of contact. 
 
For this demonstration, view the highlighted point of contact 
information. 
 
Select Next to continue. 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Detailed carrier information is displayed in 
the Carrier portlet, including tabs that contain information pertaining 
to carrier Contacts, Addresses, Drivers/Crew, Conveyances, 
Equipment, Shippers, and Consignees. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 8 
 
Now we will demonstrate how to add a point of contact not already in 
the ACE program.  
 
Note: If you have searched for a carrier contact and the name is not 
listed, select the Create button to add a new company contact to ACE. 
 
Text caption displays: Select the Create button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. The Create button is contained in the Carrier 
portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 9 
 
To begin, select the appropriate contact type from the drop-down 
menu and enter the contact information.  We have entered the 
information for you in this simulation. 
 
Once completed, select Save. 
 
Text caption displays: Select the Save button 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Form fields associated with the carrier’s 
point of contact are displayed in the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 10 
 
The Carrier panel displays. 
 
If you cannot see the bottom of the Carrier panel, scroll down to 
confirm that ACE has added the point of contact information. 
 
Select Next to continue. 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Detailed carrier information is displayed in 
the Carrier portlet, including tabs that contain information pertaining 
to carrier Contacts, Addresses, Drivers/Crew, Conveyances, 
Equipment, Shippers, and Consignees. The new point of contact is 
listed in the Contacts tab. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Screen 11 
 
The Technology Support Center 
 
For additional assistance, call the Technology Support Center 1-866-
530-4172 and follow the prompts. 
 
The Technology Support Center is available 24 hours a day and 7 days 
a week. 
 
Select Next to continue. 
 
Image: A woman working at computer 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 12 
 
You have completed Lesson 5: Adding a Company Contact 
   
In this lesson, you learned how to add a point of contact to your carrier 
record both by using an existing person in ACE and by adding a new 
person. 
 
Select Exit to return to the Menu. 
 
Image:  Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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Lesson 6 Editing Your Carrier Record 
 
Screen 1 
 
Lesson 6: Editing Your Carrier Record 
 
Lesson 6 teaches you how to edit carrier records in the Automated 
Commercial Environment (ACE) secure data portal. 
 
After completing this lesson, you will be able to: 
 

• Edit you carrier record. 
• Add Department of Transportation (DOT) number, cargo release 

notification method, and insurance to a carrier record. 
 
Select Next to continue. 
 
Image:  Computer monitor displaying the ACE logo. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 2 
 
For this demonstration, we have entered the carrier's Taxpayer ID 
number, organization structure, street address, and the points of 
contact. 
 
The remaining required information for the carrier is: 

• Department of Transportation number or DOT 
• Cargo release notification 
• Other company name 
• Insurance if carrying hazardous materials 

 
To edit information currently saved in ACE or to add information, 
select the Edit button. 
 
Text caption displays: Select the Edit button 
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Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. The Edit button is contained in the Carrier 
portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 3 
 
The Carrier panel allows you to edit the carrier's information. 
 
If applicable, you should ensure that DOT #, Cargo Release 
Notification, Other Company Name, and Insurance information are 
entered accurately.  We have entered the DOT # and Cargo Release 
Notification data for you. 
 
Note: If the company does not have a US DOT number, type the 
default 99999. 
 
Text caption displays: Select the Save button. 

 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Form fields associated with the Carrier 
Information are displayed in the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 4 
 
We have simulated completing the DOT# and cargo release notification 
information. 
 
Select Next to continue. 
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Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Detailed Carrier information is displayed in 
the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 5 
 
You are now ready to use your Carrier portal account.  Before you 
begin to create an e-Manifest, you should enter certain data to the 
Carrier screen.  Entering Drivers/Crew, Conveyances, Equipment, 
Shippers, and Consignees can simplify the process of creating e-
Manifests. 
 
There are several hyperlinks for the Point of Contact name you just 
created.  Select any of these hyperlinks to navigate to a screen where 
you can enter the data.   
 
For specific instructions on how to set up these records in your portal 
account, please take the Web Based Training (WBT) - e-Manifest: 
Trucks R4. 
 
Select Next to continue. 
 
Image: ACE secure data portal with the Accounts tab displayed and 
the Carrier view selected. Detailed Carrier information is displayed in 
the Carrier portlet. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
 
 
 

46 



Web-based Training Guide for  Module 2, Lesson 6 
ACE Initial Login for Trade Account Owners 

47 

Screen 6 
 
The Technology Support Center 
 
For additional assistance, call the Technology Support Center 1-866-
530-4172 and follow the prompts. 
 
The Technology Support Center is available 24 hours a day and 7 days 
a week. 
 
Select Next to continue. 
 
Image: A woman working at computer. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
 
 
Screen 7 
 
You have completed Lesson 6: Editing Your Carrier Record 
   
In this lesson, you learned how to add the following information to a 
carrier record: 
 

• Department of Transportation (DOT) number. 
• Cargo Release Notification. 
• Insurance data. 

 
Select Exit to return to the Menu. 
 
Image:  Purple rectangle surrounding the screen text. A computer 
monitor displaying the ACE logo is in the lower-right corner of the 
purple rectangle. 
 
Buttons:  
Select Pause to temporarily stop the course. 
Select Back to return to the previous screen. 
Select Next to continue. 
Select Exit to return to the course menu screen. 
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